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This index lists all Help topics available for the Compose application. To learn how to use 
Help, press F1 or choose Using Help from the Help menu.

Note that the Compose application and Help use the notation <sp> to refer to the spacebar.
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If you have any problems with Compose or have any comments, please fill out COMPOSE 
and email it to cummings@pixel.enet.dec.com.



New    (File Menu)
Creates a new set of compose sequences, which will include only four pre-defined 
sequences:

1. Today's date, <Compose> D<sp>
2. Current Time, <Compose> T<sp>
3. Today's date and the current time, <Compose> DT
4. Choose dialog box, <Compose> <sp><sp>

In order to save this set or any additions to this set, Save As must be used.



Open    (File Menu)
Display a dialog box containing directories and files so that a previously saved set of 
compose sequences may be opened. The current set of compose sequences is discarded.
See Open Dialog Box.



Save    (File Menu)
Saves the currently defined set of compose sequences to disk. The filename will be that 
which is displayed in the Compose application's main window.



Save As    (File Menu)
Saves the currently defined set of compose sequences to disk. A dialog box is provided 
to name the file. See Save As Dialog Box.



Print Compose Sequences (File Menu)
Brings up a dialog box allowing all currently defined compose sequences to be printed. 
See Print Compose Sequences Dialog Box.



Print Font    (File Menu)
Bring up a dialog box so that all the characters of a font, with their numeric codes, can 
be printed. A sample string may also be printed. See Print Font Dialog Box.



Exit    (File Menu)
Exits the application. If modifications to the current set of compose sequences have not 
been saved, a message box will provide an opportunity to do so.



Recently used files    (File Menu)
The names of the eight most recently used compose sequence files will be appended to 
the bottom of the File menu. Simply select one to load it, discarding currently defined 
compose sequences.



Peruse Screen Fonts    (Compose Menu)
Peruse Screen Fonts will bring up a dialog box permitting rapid and easy perusal of all 
installed screen fonts. This dialog box can also be activated by pressing and releasing 
the Compose key and typing two spaces. If you select a character it will be sent to the 
window that had focus when the compose sequence was used. See Choose Dialog Box.



Define Sequences    (Compose Menu)
Define Sequences will bring up a dialog box allowing modifications to be made to the 
currently defined set of compose sequences. Compose sequences may be added, 
deleted, or    modified. See the Defining New Compose Sequences or Define Sequences 
Dialog Box for more information.



Long Date Format (Compose Menu)
Select Long Date Format to toggle the format of date that the DT and D<sp> compose 
sequences return. This item will be check marked if the Long date format (as specified in 
WIN.INI and maintained by the Control Panel/International dialog box) is to be used or 
unchecked if the Short date format (also from WIN.INI) is to be used. 



Enable/Disable Compose    (Compose Menu)
These two menu items control the operation of the Compose application. Compose starts
up as enabled, so that it is monitoring keyboard activity and will notice when the 
currently defined compose key is pressed. If you suspect that Compose may be 
interfering with another application, choose Disable from the Compose menu. Simply use
the Enable menu item to reactivate Compose.

Enable/Disable are also on the system menu so that you can disable and enable 
Compose after it has been minimized (appears as an icon instead of a window.)



Quick Access to Fonts    (Compose Menu)
This menu item disables all compose sequences and forces the Compose key to act as if 
the <space><space> sequence was entered, i.e. the Choose dialog box comes up so 
that all installed screen fonts can be viewed. 

This menu item is typically selected when the main use of Compose is to have easy 
access to symbol and "dingbat" fonts, where most of the glyphs of the font aren't 
alphanumeric. Simply select this menu item again to re-enable all compose sequences.    
See Choose Dialog Box.



Set Key    (Compose Menu)
This menu item allows a new compose key to be defined. By default, the compose key is 
the Ctrl key located on the right hand side of the space bar. If your keyboard doesn't 
have this key, or you would like to define a different one, start by selecting the Set Key 
menu item. The Compose window will now display a prompt indicating that you should 
press and release the preferred key.

Choose a key that is convenient to use, but won't conflict with other applications. Alt and
Ctrl are allowed as modifiers. For example, F2      and Alt-F12 are valid keys. Recall that 
you can disable Compose if your preferred compose key only conflicts occasionally with 
the accelerators of some application.

To leave Set Key mode without making any changes, press the Esc key.



Default Key    (Compose Menu)
Restores the Ctrl key to the right of the space bar as the compose key.



Compose Sequence

A mnemonic sequence of characters, often associated with a single character not found 
on the keyboard, or with a string. Some examples: pressing the compose key, then '1' 
and '2' would result in the character '½', 'c' and 'o' would result in the character '©', and 
'd', 'e', and 'c' would result in the string "Digital Equipment Corporation".



Overview
You may want to maximize the window size before reading this section.
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Compose enhances the Windows environment in several ways. It allows quick, easy access 
to characters not found on your keyboard, application independent access to the current 
date and time, and the ability to peruse, and select from, the characters of a font. Compose 
also enables you to easily print out all the characters of a font, in your choice of size and 
style.

The supported Windows method for entering any character, especially those not on your 
keyboard, is to type a value on the numeric keypad while holding an Alt key down. If 
entering a code for the OEM character set, "simply" enter the three digit code. If entering a 
code for the ANSI character set, type a '0' (zero) on the numeric keypad and then enter the 
three digit ANSI code. Refer to your Windows documentation for more information about this 
method.

Using the numeric keypad to enter a special character can be awkward and distracting. 
Many people familiar with Digital Equipment Corporation terminals and workstations are 
familiar with the compose key and compose sequences. The idea is simple: 

Press a special "compose" key (symbolized by C), and then two characters that 
mnemonically represent the desired character. <C> <1> <2> for ½, <C><a><"> 
for ä, or <C><c></> for ¢ are all more easily remembered than their numeric codes.

Compose provides a set of pre-defined compose sequences so that easy access to many of 
those hard-to-use characters is immediately available. These pre-defined sequences are 
those that are normally available on DEC terminals and workstations. Choosing Define 
Sequences from the Compose menu will allow you to peruse defined compose sequences.

Compose also pre-defines four other compose sequences. Three of these offer combinations 
of today's date and current time, and the fourth pops up a dialog box containing a list of 
installed screen fonts with a list of characters for the selected font. You can simply double-
click on one of these characters and it will be sent to the current application.

Note that while Compose works with many Windows applications, it won't work with all 
Windows applications. Compose needs to shift input focus around to do its work, and some 
applications (like Paint) are sensitive to this. If this happens to be a problem you can still use
Compose as an aid for typing in special characters. Bring up the Choose dialog box as you 
normally would. Instead of double-clicking on a character, single click on it and note its ANSI 
or OEM code. Cancel the dialog box and return to your application. Press, and hold, the Alt 
keydown; use the numeric keypad to type in the numeric code for the desired character.

In addition to using pre-defined compose sequences, you can define new compose 
sequences.    This often provides a more mnemonic method to create "macros" for simple 
text. Compose sequences don't have to result in a single character; you can define a 
compose sequence that results in a string. For instance, one of the compose sequences 
shipped with Compose is "DEC" which results in the string "Digital Equipment Corporation."

Assuming that you have Compose running right now, give it a try, noting that the default 
compose key (symbolized by C) is the Ctrl key to the right of the space bar:



Start up the Notepad application. The strings that we want to create are on the left 
and the keystrokes to produce them are on the right:

It took 1½ minutes. [It took 1C12 minutes.]
¿Aquí? [C??Aquci'?] 
4×2 + 4÷2 [4Cxx2 + 4C:-2]

Related Topics:
Using Compose Sequences
Defining a New Compose Key
Short Cut for the <sp><sp> Sequence

Defining New Compose Sequences
Viewing Currently Defined Compose Sequences
Printing Currently Defined Compose Sequences

Print a Font

Starting the Compose Application
Disabling and Enabling the Compose Application
Using WIN.INI



Using Compose Sequences
Using compose sequences is quite simple.    In the Compose application's window you will 
see which key is currently defined as the compose key. By default this will be the Ctrl key to 
the right of the space bar. To enter a compose sequence, press and release the compose key.
You should see a rectangular indicator titled "Compose" appear in the lower right corner of 
your screen. You may now type the characters that make up the sequence, such as 'c' and 
'o'. As soon as you've typed a valid compose sequence, the indicator should disappear and 
the character or string that resulted from the compose sequence should appear in your 
application.

If you enter an invalid compose sequence you will hear a beep and the indicator will be titled
"Invalid." This indicator will disappear in a few seconds. To abort any compose sequence, 
simply press the Esc key or the Backspace key.

Please note that Compose only provides characters to an application. It is not capable of 
telling another application to change fonts. It is important to remember this when using the 
Choose dialog box that results from the <sp><sp> sequence. You may have selected the 
Symbol font and double-clicked on one of the characters of the Symbol font, but you won't 
get that character unless you changed the application's current font to Symbol before 
invoking the compose sequence.

Related topics:
Viewing Currently Defined Compose Sequences
Choose Dialog Box



Defining a New Compose Key
The Set Key menu item (under Compose) allows a new compose key to be defined. By 
default, the compose key is the Ctrl key located on the right hand side of the space bar. If
your keyboard doesn't have this key, or you would like to define a different one, start by 
selecting the Set Key menu item. The Compose window will now display a prompt 
indicating that you should press and release the preferred key. Choose a key that is 
convenient to use, but won't interfere with other applications. Alt and Ctrl are allowed as 
modifiers. For example, F2      and Alt-F12 are valid keys. Note that you can disable 
Compose if your preferred compose key only occasionally conflicts with accelerators for 
some application.

The Default Key menu item (also under Compose) restores the Ctrl key to the right of the
space bar as the compose key.



Defining New Compose Sequences
With Compose you can define new sequences, as well as modify and delete existing ones. 
Use the Define Sequences menu item (under Compose) to bring up a dialog box for these 
activities.

To add a new compose sequence, you must decide on the sequence of characters that you 
would like to use. Compose sequences can be no more than five characters and must not 
conflict with existing compose sequences. For ease of use, something mnemonic will be 
easier to remember and use.

You must also decide on whether or not the compose sequence should be case sensitive. For
compose sequences such as 'A', '^' for 'Â' and 'a', '^' for 'â', case is important. For compose 
sequence such as 'c', 'o' for '©' and 'c', '/' for '¢', case probably isn't important.

Another option for compose sequences is whether or not the characters must be specified in
a specific order. For compose sequences such as '1', '2' for '½' and '1', '4' for '¼', it makes 
sense that they occur in a certain order. For compose sequences such as 'p', '!' for '¶' and '-',
'+' for '±', order probably isn't important.

There are some special codes that allow you to enter non-standard characters into a 
compose sequence result:

\n Puts a carriage return into the string.

\t Puts a tab into the string.

\xnn Puts a character defined by a hex code into the string. (e.g. \xA2)

\dnn Puts a character defined by a decimal code into the string.

See Define Sequences Dialog Box.



Viewing Currently Defined Compose Sequences
Use the Define Sequences menu item (under Compose) to display a dialog box containing a 
list of currently defined compose sequences. This dialog box is normally used to add, modify,
and delete compose sequences, but also serves as an easy way to view existing ones. See 
Define Sequences Dialog Box.



Printing Currently Defined Compose Sequences
The currently defined compose sequences can be printed by using the menu item Print from 
the File menu. This will bring up a dialog box allowing you to choose and setup the printer 
that you would like the compose sequence definitions to be printed on. See Print Compose 
Sequences Dialog Box.



Printing a Font
You may print the characters of a font, their character codes, and a sample string by 
selecting Print Font from the File menu. This will bring up a dialog box allowing you to pick a 
font, size, and style to be printed. See Print Font Dialog Box.



Starting the Compose Application
Like any Windows application, there are four ways to start Compose:

1.    Use the Run dialog box from the Program Manager's File menu.
2.    From the DOS command line: WIN COMPOSE.
3.    Add Compose to the "run=" line in WIN.INI: run=compose
4.    Add Compose to the "load=" line in WIN.INI: load=compose

Option 4 is generally the best method. Compose starts automatically and unobtrusively, and 
is ready when you need it.



Disabling and Enabling the Compose Application
If the currently defined compose key temporarily conflicts with your application, or if 
Compose appears to conflict in some other way, you can disable Compose rather than 
closing it down.

Use Disable Compose item from the Compose menu to do this. After the problem area has 
been resolved or passed over, you can select Enable Compose from the menu.

Disabling and enabling Compose can also be done from the system menu, allowing these 
actions to be performed from the Compose icon.



Using WIN.INI
BE CAREFUL WHEN MODIFYING WIN.INI WITH A TEXT EDITOR!

The Compose application keeps track of recently visited files in WIN.INI. If you would like to 
clear the list of recently visited files, edit the WIN.INI file in your Windows directory and 
search for the string "[Compose]". Below that there will be a line of text beginning with 
"Files=". Delete this line and restart Compose to clear the list of recently visited files.

Another modification you might wish to make is to control the Compose application's use of 
memory. By default, the memory that it allocates from Windows' global heap is discardable. 
The effect of this is that if you don't use Compose for a long time, its tables might be 
discarded. You may notice a slight delay the next time that you use Compose while data is 
reloaded from disk.

You can control whether or not Compose uses discardable memory by adding a line 
underneath the "[Compose]" line in your WIN.INI file. Add the line "DiscardableMemory=0" to
disable Compose's use of discardable memory. Change it to "DiscardableMemory=1" (or 
simply delete the line) to enable use of discardable memory.

The font used in the list of characters in the Choose dialog box can also be controlled from 
WIN.INI. Add "ChooseDialogFont=<fontname>" where fontname is one of the screen fonts 
installed on your system. This value is also updated as different fonts are chosen within the 
Choose dialog box.

The point size of the font used to list the characters in the Choose dialog box can also be 
controlled from WIN.INI. The point size can be set by adding a line 
"ChooseDialogPointSize=nn" where "nn" is the desired point size. By default, Compose 
uses a point size of 14 for the listbox of characters. This value is also manipulated with the 
'«' and '»' buttons and scrollbar in the Choose dialog box.

The last variable maintained in WIN.INI is "QuickAccessToFonts". If this variable is set to 1, 
the compose key will go directly to the Choose dialog box; no other keys are necessary. If 
equal to zero, this feature is turned off.



Open Dialog Box
The Open dialog box is used to open a file of previously saved compose sequences. 

Open File Name edit field:
File names and file filters may be entered in the Open File Name field. If a drive and 
directory aren't specified, Open will use the drive and directory specified in the Files 
In field. Wildcards, such as *.DAT and ABC??.DAT, may be used in this field to cause 
the listbox to fill in with files matching that wildcard pattern.

Also in the list box will be items such as "[..]" which means go up one level in the 
directory tree, or "[subdir]" which means go to a subdirectory, and "[-c-]" which 
means go to a drive.

Ok button:
To select a file you may select it with the mouse or keyboard and click on the Ok 
button or you may press the Enter key. You may also simply double click on a 
filename within the listbox to open that file.

Cancel button:
You may leave this box without opening any file by clicking on Cancel or by pressing 
the Esc key.



Save As Dialog Box
The Save As dialog box is used to save the current set of compose sequences to a different 
file than that which was loaded, or to save a New set of compose sequences.

Save File As edit field:
A valid filename must be entered in this field, wildcards are not allowed. If no drive or
directory is specified within this field, the drive and directory displayed above this 
edit field will be used.

Ok button:
Click on the Ok button, or press the Enter key, to have Compose save the current set 
of compose sequences to the file named in the edit field. If the file specification is 
invalid (such as an incorrect drive letter or mis-spelled directory) the dialog box will 
beep.

Cancel button:
Click on the Cancel button, or press the Esc key, to leave the dialog box without 
saving the compose sequences.



Print Compose Sequences Dialog Box
The Print Compose Sequences dialog box is used to print the entire set of compose 
sequences to one of the available printers. The listing will have the characters of the 
compose sequence, a checkmark indicating if the sequence is order sensitive, a checkmark 
indicating if the sequence is case sensitive, and finally the string that results from the 
compose sequence.
Printer listbox:

This listbox will contain the names of all available printers. If the printer you need 
isn't listed, you should go to the Control Panel's Printers application to add it or to 
make it active.

Ok button:
Click on the Ok button, or press the Enter key, to have Compose print all the currently
defined compose sequence to the printer that is highlighted in the Printers listbox.

Cancel button:
Click on the Cancel button, or press    the Esc key, to dismiss the dialog box without 
printing anything.

Setup button:
Click on the Setup button, or press Alt-S, to bring up the Setup dialog box of the 
printer that is currently highlighted in the Printers listbox.



Print Font Dialog Box
The Print Font dialog box isn't directly related to compose sequences but may be used as a 
method to preview all the characters of a particular printer font. In addition to printing the 
character, the ANSI and OEM character codes are printed for each character.

Printer listbox:
This listbox will contain the names of all available printers. If the printer you need 
isn't listed, you should go to the Control Panel's Printers application to add it or to 
make it active.

Ok button:
Click on the Ok button, or press the Enter key, to have Compose print all the currently
defined compose sequence to the printer that is highlighted in the Printers listbox.

Cancel button:
Click on the Cancel button, or press    the Esc key, to dismiss the dialog box without 
printing anything.

Setup button:
Click on the Setup button, or press Alt-S, to bring up the Setup dialog box of the 
printer that is currently highlighted in the Printers listbox.

Font listbox:
This listbox lists all fonts currently available for the printer highlighted in the Printers 
listbox. The font highlighted here when the Ok button is pressed is the font that will 
be printed. Clicking on a font will cause the Point Size combo-box to be reset with 
valid or typical point sizes for that particular font. 

Point Size combo-box:
This combo-box is an edit field and an associated drop-down listbox. The drop-down 
listbox will list the point sizes ranging from 8 to 96 for scalable printer fonts, or it will 
list just those sizes supported by the printer for non-scalable fonts. You can enter a 
value other than those listed in the drop-down listbox in the edit field portion of the 
combo-box, and Compose will attempt to print the font in that size, but the quality 
and availability of that size depend upon the font, the printer, and Windows.

Bold check-box:
Toggling this field on will cause the font to be bolded.

Italic check-box:
Toggling this field on will cause the font to be italicized.

Sample String edit field:
The contents of this field will be printed out on a separate page, using the selected 
font, after all the characters in the font have been printed. 



Choose Dialog Box
The Choose dialog box comes up either as a result of the <sp><sp> compose sequence or 
because Peruse Screen Fonts was chosen from the menu. There are two primary uses for 
this dialog box.

First, the Choose dialog box can be used to pick a character out of all the available 
characters for a screen font. This can be handy for those characters that you don't have or 
don't remember a compose sequence for, and is especially useful for symbol and dingbat 
fonts. If looking at symbol fonts and dingbat fonts is your main use of Compose, consider 
using the Quick Access to Fonts feature of Compose.

Second, the Choose dialog box can be a convenient way to scan all available screen fonts 
and their contents. This can be a great convenience when trying to use the increasing 
number of scalable fonts that are becoming available commercially as well as those in the 
public domain.

It is important to note that while this dialog box lets you view different fonts, styles, and 
sizes, it cannot affect the application from which Compose was used. You still need to use 
that application's procedures for selecting fonts, styles, and sizes.

Characters listbox:
This listbox will list all the characters of a screen font. The size and style of the 
characters is determined by other fields in the Choose dialog box. As you select a 
character, the OEM and ANSI code fields will update. You may notice the first 
character code of many fonts isn't 0 nor is the last character 255. This is quite normal
for Windows ANSI fonts. If you brought the dialog box up by using the <sp><sp> 
compose sequence you can select the character and click on the Ok button to have 
that character sent to your original application. You can also simply double click on 
the character. Either of these actions will dismiss the Choose dialog box.

Fonts listbox:
This listbox lists all the available screen fonts. It is important to note that these are 
screen fonts, not printer fonts. You may very well see a different list of fonts if you go
to the Print Font dialog box. However, there often is a printer font for a corresponding
screen font, especially with the emerging technology of scalable fonts for Windows.

Bold check-box: 
This will bold or un-bold the characters in the characters listbox.

Italic check-box:
This will italicize or un-italicize the characters in the characters listbox.

OEM and ANSI fields:
The value of these fields will display the corresponding OEM or ANSI character codes 
of the character highlighted in the characters listbox.

« and » buttons:
These two buttons can be used to reduce and enlarge the size of the characters 
displayed in the characters listbox. The current point size is displayed just above the 
scrollbar, between these two buttons. Where as the scrollbar will change the point 
size by half the distance between the current position of the slider and the end 
position, these two buttons try to reduce and enlarge the font in more practical steps.



Point size scrollbar:
This scroll bar reflects as well as changes the point size of the characters list in the 
characters listbox.

Ok button:
This causes the currently selected character to be sent to the originating application. 
Compose will attempt to determine whether to send the OEM or ANSI code, but it 
isn't foolproof. The dialog box is dismissed and focus returns to the originating 
application.

Cancel button:
This dismisses the dialog box and focus returns to the originating application.

Print button:
This causes the Print Font dialog box to pop up. Compose will attempt to initialize the 
Print Font dialog box with corresponding values from the Choose dialog box. See Print
Font Dialog Box.



Define Sequences Dialog Box
This dialog box is used to view, add, delete, and replace compose sequences. Please note 
that this dialog box does not cause the sequences to be saved to disk; use Save or Save As 
from the File menu to do that.
There are some special codes that allow you to enter non-standard characters into a 
compose sequence result:

\n Puts a carriage return into the string.

\t Puts a tab into the string.

\xnn Puts a character defined by a hex code into the string. (e.g. \xA2)

\dnn Puts a character defined by a decimal code into the string.

Sequences listbox:
This listbox lists all compose sequences. It shows the characters of the sequence, 
whether or not it is order sensitive, whether or not it is case sensitive, and what the 
resulting string of the compose sequence is.

To modify or delete a sequence, it must first be selected from this listbox.

There are edit fields and check-boxes below the listbox that are used to add or modify
sequences.

Ok button:
Dismisses the Define Sequences dialog box and retains the changes. This does not 
save this set of compose sequences to disk.

Cancel button:
Dismisses the Defines Sequences dialog box without making any changes to the 
current set of compose sequences.

Add button:
Adds the compose sequences defined in the fields below the listbox to the list of 
defined compose sequences. Some limited checking is done to help avoid conflicts 
with other compose sequences.

Replace button:
To replace the definition of a compose sequence, first select it from the listbox, this 
will fill in the fields below the listbox. Make your changes to the compose sequence 
and click on the replace button to replace the old definition with the new. Some 
limited checking is done to help avoid conflicts with other compose sequences.

Delete button:
To delete a compose sequence, select it from the listbox and click on the Delete 
button.

Choose button:
To gain easy access to un-oridinary characters when defining a compose sequence, 
the Choose button will bring up the choose dialog box so that you may scan fonts and
select the character that you need.






